Revit Architecture

Getting Started with Revit Architecture
Contents

Chapter 1  Getting Started ................................................................. 1

Introduction ................................................................. 1
Creating a Project ......................................................... 3
Creating Walls ............................................................... 6
Creating Terrain ........................................................... 7
Adding Exterior Walls ..................................................... 10
Adding a Roof ............................................................... 11
Adding Floors ............................................................... 13
Adding Interior Walls ...................................................... 15
Adding Doors ............................................................... 17
Adding Windows .......................................................... 19
Adding a Curtain Wall ...................................................... 23
Attaching Walls to the Roof ................................................ 24
Modifying the Entry Deck ................................................... 25
Adding a Sloped Floor ....................................................... 28
Adding Stairs and Railings ................................................... 29
Modifying the Roof ........................................................ 34
Documenting the Project .................................................... 35
Creating a Solar Study ......................................................... 40
Creating a Sheet ............................................................. 41
Welcome to Revit® Architecture 2009! We hope you enjoy learning and using this revolutionary parametric building modeller. Revit Architecture is designed to accommodate various ways of working, so that you can concentrate on your building models rather than on adapting your methodology to the demands of the software. In this short tutorial, you learn how to use the features of Revit Architecture to design, change, and document a building. You learn how you can make design changes in any view of the building, and the parametric change engine in Revit Architecture coordinates those changes in all other views.

Introduction

Installation

Before beginning the exercises, install the software and register it as either demo or subscription. Demo mode serves as a no-cost viewer, allowing you to export, print, or plot projects that have not been edited.

Imperial and Metric Convention

The exercises in this guide contain both imperial and metric values. This means that when you see an imperial value, a metric value is displayed in square brackets next to it.

For example: In the Type Selector, select Basic Wall : Generic - 6\" [200mm].

All audiences using the metric measurements should follow the metric values in brackets only; all metric measurements are in millimeters. Note that the imperial and metric values are not direct conversions, but appropriate values for completing either the imperial or metric project.

Exploring the User Interface

When the Revit Architecture window is displayed, take a minute to view the different sections.
Menu Bar and Toolbars

At the top of the window is the standard Microsoft® Windows®-based menu bar, from which you can access all Revit Architecture commands. Icons on the toolbars are buttons for executing common Revit Architecture commands.

Options Bar

Below the toolbars is the Options Bar, which displays command options for the current operation. If you click Wall on the Design Bar on the left side of the Revit Architecture window, the Options Bar displays options related to the Wall command.

Type Selector

On the left side of the Options Bar is the Type Selector, a drop-down menu that lists different types of elements to add to a project. You can choose an element type by selecting it from the drop-down menu of the Type Selector.

Properties Button

To the right of the Type Selector is the Properties button, which accesses a dialog in which you can change various parameters of a selected component.

Design Bar

On the left side of the Revit Architecture window is the Design Bar, which lists the commands available for the currently selected tab. There are 10 tabs: Basics, View, Modelling, Drafting, Rendering, Site, Massing, Room and Area, Structural, and Construction. To see all the tabs, right-click on the Design Bar. To display a single tab, click the tab name.
Project Browser

To the right of the Design Bar is the Project Browser. The Project Browser is a listing of all views, families, and groups in the project. You can select any of the items listed in the Project Browser. A convenient way to open a view is to double-click the view name in the Project Browser list.

Status Bar

At the lower left corner of the drawing area is the Status Bar, which displays the status of the current command or the name of a highlighted element.

View Control Bar

At the lower left corner of the drawing area, above the Status Bar, is the View Control Bar. The controls are graphical shortcuts to various View commands, namely scale, detail level, graphics style, advanced model graphics, shadows, crop region, and temporary hide/isolate. Some views, such as sheets, drafting, and rendered views, have limited controls.

Drawing Area

The drawing area of the Revit Architecture window displays views (and sheets and schedules) of the current project. By default, each time you open a view in a project, the view displays in the drawing area on top of other open views. You can use commands on the Window menu to arrange the project views.

Communication Center

The Communication Center provides quick access to resources at Autodesk, such as Live Update maintenance patches, subscription information, articles, tips, and product support information. For more information, see the Revit Architecture Help.

Getting Started

Now that you have explored the interface, you can start your first project. In this project, you use some of the basic commands found in Revit Architecture. The exercises show how easy it is to design a simple building with no previous experience.

Creating a Project

In this first exercise, you create and name a project in which you will create the building model shown.
1 Create a project:
- In the drawing area, under Projects, click New.
- In the New Project dialog, under Create New, verify that Project is selected.
- Under Template file, verify the second option is selected, and click Browse.
- In the left pane of the Choose Template dialog, click Training Files, and open \Imperial\Templates [Metric\Templates].
- Select default.rte [DefaultMetric.rte], and click Open.
- In the New Project dialog, click OK.

2 Name and save the project file:
- Click File menu ➤ Save.
- In the left pane of the Save As dialog, click Training Files, and then, in the file window, double-click Imperial [Metric].
- For File name, enter Getting_Started, and click Save.

3 Zoom to a view:
- In the Project Browser, double-click Elevations (Building Elevation) ➤ South.
- Enter ZR, to zoom to a specific region.
  Note that the cursor changes to a magnifying glass.
- In the drawing area, move the cursor diagonally and click to draw a rectangle around the level markers.
  The area within the rectangle is magnified to fill the drawing area so that you can work with the level marker text.
4 Rename levels:

- Double-click the Level 1 text, enter 00 Foundation, and press ENTER.
  Use a number as a prefix to the name so the plans are sorted by level.

- In the alert dialog, click Yes to rename corresponding views.
  The floor and ceiling plans for Level 1 are renamed 00 Foundation.

- Using the same method, rename Level 2 and its corresponding views as 01 Lower Level.

5 Create levels in the building:

- Enter ZO to zoom out.

- On the Design Bar, click Level.

- On the Options Bar, click (Pick Lines), and, for Offset, enter 10' [3000mm].

- In the drawing area, highlight the 01 Lower Level line; when a dashed line is displayed above
  the level line, click to create a level (Level 3).

- Using the same method, create a level above Level 3.

6 On the Design Bar, click Modify to end the command.

7 Rename the new levels and all corresponding views:

- Level 3: Rename as 02 Entry Level

- Level 4: Rename as 03 Roof

8 Double-click the level dimensions, and enter new values:

- 0'0" [0mm]: Change to -14'0" [-5250mm]

- 10'0" [4000mm]: Change to -10'0" [-3050mm]
Creating Walls

In this exercise, you work on different levels to add foundation walls to the project.

1. In the Project Browser, under Floor Plans, double-click 00 Foundation to open that view in the drawing area.
2. On the Design Bar, click Wall.
3. In the Type Selector, select Basic Wall : Retaining - 12” Concrete [Basic Wall : Retaining - 300mm Concrete].
4. On the Options Bar:
   - Click \( \text{(Draw)} \).
   - For Height, select 02 Entry Level.
   - For Loc Line, verify that Wall Centerline is selected.
   - Verify that Chain is selected.
5. In the drawing area, draw walls on the foundation level:
   - Click in the lower right quadrant to select the wall start point.
   - Move the cursor to the left, enter 40’ [12000 mm], and press \( \text{ENTER} \).
   - Beginning at the new endpoint, move the cursor up, enter 22’ [6900 mm], and press \( \text{ENTER} \).
   - Move the cursor to the right, enter 40’ [12000 mm], and press \( \text{ENTER} \).
6. On the Design Bar, click Modify to exit the command.
7. In the Project Browser, under Floor Plans, double-click 01 Lower Level.
8. On the Design Bar, click Wall.
9. In the Type Selector, select Basic Wall : Foundation - 12” Concrete [Basic Wall : Foundation - 300mm Concrete].
10. On the Options Bar, for Depth, select 00 Foundation.

NOTE You do not need to specify the unit; Revit Architecture uses the units specified in the project template.
11 Draw walls on the lower level:
- In the drawing area, click the right endpoint of the south wall as the wall start point.
- Move the cursor to the right, enter 6’ 6” [1950 mm], and press ENTER.
- Move the cursor up, enter 5’ [1500 mm], and press ENTER.
- Move the cursor to the right, enter 10’ 6” [3150 mm], and press ENTER.
- Move the cursor up, and select the intersection with the extension of the north wall.
- Select the right endpoint of the north wall to complete the chain and connect the walls.

12 On the Design Bar, click Modify.

13 Save the project file.

Creating Terrain

In this exercise, you create a 3D view and add a toposurface to the building site.

1 In the Project Browser, under Floor Plans, double-click 02 Entry Level.
2 Create a 3D view:
- Click the View tab of the Design Bar, and click Camera.
- Click in the upper right corner of the drawing area to place the camera.
- Click to place the camera target point, as shown.
A 3D view is created. The view you create may differ slightly from the illustrations shown in the exercises because of minor variations in camera placement. Drag the blue circular controls that display on the crop region of the resulting view so that you can see the building.

3 In the Project Browser, expand 3D Views, right-click 3D View 1, and click Rename.
4 In the Rename View dialog, enter To Building, and click OK.
5 Create a graded building site:
   ■ In the Project Browser, under Floor Plans, double-click Site.
   ■ Click the Site tab of the Design Bar, and click Toposurface.
   ■ On the Options Bar, for Elevation, enter -0' 6'' [-150 mm].
   ■ Add points to the left of the building, as shown. The order of the point selection is not important.
   ■ On the Options Bar, for Elevation, enter -10' [-4000 mm].
Add points near the center of the building, as shown. Contour lines are displayed.

On the Options Bar, for Elevation, enter -11' [-4300 mm].

Add points to the right of the building, as shown.

On the Design Bar, click Finish Surface.

6 Create a pad surface:
   • On the Design Bar, click Pad, and then click Lines.

   • On the Options Bar, click (Rectangle).

   • Select the outer endpoint at the lower left of the building, as shown.
7 Select the outer endpoint at the upper right of the building.
8 On the Design Bar, click Finish Sketch.

7 Open the To Building 3D view to see the results.
8 Save the project file.

In this exercise, you created a simple toposurface in Revit Architecture by selecting points. However, for most projects, complex site models created by civil engineering professionals will be provided to you in DWG, DXF, DGN, or point files. You can import these files into your Revit Architecture project where you can automatically generate a terrain using the Toposurface tool.

Adding Exterior Walls

In this exercise, you build upon the foundation walls. You use the Draw option to create exterior walls that extend to the roof level.

1 Add walls to the entry level:
   ■ In the Project Browser, under Floor Plans, double-click 02 Entry Level.
   ■ Click the Basics tab of the Design Bar, and click Wall.
   ■ In the Type Selector, select Basic Wall : Generic - 6" [Basic Wall : Generic - 200mm].
   ■ On the Options Bar, for Height, select 03 Roof, and for Loc Line, select Core Face: Interior. The Height setting defines how tall the wall is and establishes a relationship between the walls and the roof. After you draw the walls, if you change the roof height, the height of the walls will also change.
Beginning at the bottom right, trace the interior of the 3 existing retaining walls by selecting endpoints.

On the Design Bar, click Modify.

2 Add walls to the lower level:

- Open the 01 Lower Level floor plan. Notice that the foundation walls are now visible at the right of the plan, so that you can trace them.

- On the Design Bar, click Wall.

- On the Options Bar, for Height, select 03 Roof.

- Beginning at the left endpoint of the north foundation wall, trace the interior of the foundation walls by selecting endpoints.

- On the Design Bar, click Modify.

3 Open the To Building 3D view.

4 Save the project file.

Adding a Roof

In this exercise, you create a roof using the footprint of the exterior walls. You specify an offset as you create the roof so that the roof has an overhang.

1 Open the 03 Roof floor plan.

2 Draw a roof line:

- On the Design Bar, click Roof ➤ Roof by Footprint, and then click Lines.

- On the Options Bar, verify that Defines slope is selected.

- To draw the first roof segment, begin at the bottom left and trace the exterior edge of the south wall by selecting the left wall endpoint and the intersection of the south and far east wall.
3 Create offset roof lines:

■ On the Options Bar, click (Pick Lines), for Offset, enter 3' [900 mm], and clear Defines slope.

■ In the drawing area, highlight the west wall; when a dashed line is displayed on the exterior of the wall, click to place the roof line. Repeat for the north and east walls.

4 Use the Trim/Extend tool to close the roof sketch:

■ On the Tools toolbar, click (Trim/Extend).

■ Select the east roof line, and then select the south roof line. Repeat for the west and south roof lines.

■ On the Design Bar, click Finish Roof.

The resulting roof has an odd slope, which you correct in the next step.

5 Modify the roof slope:

■ Select the roof, and click (Properties).

■ In the Element Properties dialog, under Dimensions, for Slope, enter 1"/12" [5°], and click OK.

■ On the Design Bar, click Modify.
6 Open the To Building 3D view.
Select and modify the crop region as necessary to see the roof. The walls are not attached to the roof; you will attach them in a later exercise.

7 Save the project file.

Adding Floors

In this exercise, you create floors in the building model.
To create floors in Revit Architecture, you must sketch them first in a sketch editor. You use 2 different sketching options, Pick and Draw, to sketch the floors.

1 Open the 01 Lower Level floor plan.
2 Create a floor using the Pick method:
   ■ On the Design Bar, click Floor, and then click Lines.
   ■ On the Options Bar, click (Pick Lines), and verify that Offset is 0.
   ■ Beginning with the north wall and moving counterclockwise, select the interior of the walls.
   ■ On the Design Bar, click Modify.
3 Enter ZR, and zoom in to the top right corner of the model.
   If the floor lines do not create a closed sketch, the sketch is invalid and you need to clean the lines up. To be valid, the sketch must be a closed loop with no disconnected or crossing lines.

4 Create a closed sketch:
   ■ On the Tools toolbar, click (Trim/Extend).
   ■ Trim as necessary, selecting the portion of each line you want to retain.

5 In the alert dialog, click No.
If you clicked Yes, the walls that finish on the lower level would be trimmed to the underside of the floor.

6 Create a floor using the Draw method:
   ■ Open the 02 Entry Level floor plan.
   ■ On the Design Bar, click Floor, and then click Lines.
   ■ On the Options Bar, click \( \text{Draw} \), and verify that Chain is selected.
   ■ Beginning at the lower left interior corner, select the lower endpoint of the west wall, and then select the upper endpoint.
   ■ Move the cursor to the right 36' [10000 mm], and click to draw the sketch line.
   ■ Move the cursor down 16'6" [5300 mm] to align with the outside of the wall, and click to specify the point.
   ■ Move the cursor to the right 25' [9000 mm], and click.
   ■ Move the cursor down 4'6' [1300 mm] to align with the inside of the wall, and click.
   ■ Move the cursor to the left, enter SZ to find the loop endpoint, and select the endpoint to complete the floor sketch.
   ■ On the Design Bar, click Finish Sketch.

7 In the alert dialog, click No.

8 View the floors in 3D:
   ■ Open the To Building 3D view.
   ■ Select the wall as shown.
Adding Interior Walls

In this exercise, you add walls on the lower level and the entry level, and then modify the walls to create rooms in the building.

1 Open the 01 Lower Level floor plan.
2 On the Design Bar, click Wall.
3 In the Type Selector, select Basic Wall : Generic - 6" [Basic Wall : Generic - 200mm].
4 On the Options Bar:
   - Click (Draw).
   - For Height, select 02 Entry Level.
   - For Loc Line, select Wall Centerline.
   - Clear Chain.
5 Add walls:
   - Zoom in to the west wall, move the cursor along the north wall centerline, enter 26' [8000 mm], and press ENTER to specify the wall start point. Move the cursor down, and click on the south wall centerline to complete wall 1.
   - On the Design Bar, click Modify.
   - Right-click on the wall, and click Create Similar.
   - Using the following illustration as a guide, place additional walls to create rooms.
6 Modify walls to create a corridor:

- On the Tools toolbar, click (Split), and click on wall 1 in the area indicated by the short line in the previous illustration.
- On the Tools toolbar, click (Trim/Extend).
- Trim the split wall to create a corridor, as shown.

7 On the Design Bar, click Modify.

8 Draw walls:

- Open the 02 Entry Level floor plan.
- Right-click on one of the half-tone walls shown in the underlay of the lower level, and click Create Similar.
Using the following illustration as a guide, place additional walls to create rooms.

9 On the Design Bar, click Modify.
The walls defining the rooms on the lower level and the entry level are complete.

10 Save the project file.

Adding Doors

In this exercise, you load doors from the Training Files folder into the project, and then add interior and exterior doors to the model.

1 On the Basics tab of the Design Bar, click Door.
   There are a limited number of door types in the project because there were few in the default template. You can load additional door types from the Training Files folder.

2 Load doors from the Training Files folder:
   ■ On the Options Bar, click Load.
   ■ In the left pane of the Load Family dialog, click Training Files, and open \Imperial\Families\Doors \Metric\Families\Doors].
   ■ While pressing CTRL, select the door types: Bifold-4 Panel.rfa, Double-Glass 2.rfa, Single-Glass 2.rfa [M_Bifold-4 Panel.rfa, M_Double-Glass 2.rfa, M_Single-Glass 2.rfa].
   ■ Click Open.

3 Add exterior doors:
   ■ Open the 01 Lower Level floor plan.
   ■ On the Design Bar, click Door.
   ■ On the Options Bar, clear Tag on Placement.
   ■ In the Type Selector, select Double-Glass 2 : 72” x 84” [M_Double-Glass 2 : 1830 x 2134mm], add a door to the east wall as shown, and then click Modify.
Open the 02 Entry Level floor plan.

On the Design Bar, click Door.

In the Type Selector, select Double-Glass 2 : 72'' x 84'' [M_Double-Glass 2 : 1830 x 2134mm].

Place the door in the north wall 7' [2100mm] from the end of the retaining wall, as shown.

In the Type Selector, select Single-Glass 2 : 36'' x 84'' [M_Single-Glass 2 : 0915 x 2134mm].

Place the door in the short vertical wall, as shown.

NOTE To change the swing direction as you place a door, press SPACEBAR. To change the swing after a door is placed, click the flip arrows.

Add interior doors:

In the Type Selector, select Single-Flush : 32'' x 84'' [M_Single-Flush : 0813 x 2134mm], and add 2 doors, as shown.

Open the 01 Lower Level floor plan.

On the Design Bar, click Door.
In the Type Selector, select Single-Flush : 30" x 84" [M_Single-Flush : 0762 x 2134mm], and place 2 doors, as shown.

In the Type Selector, select Bifold-4 Panel : 72" x 84" [M_Bifold-4 Panel : 1830 x 2134mm], and place 2 doors, as shown.

5 Open the To Building 3D view.
6 For an unobstructed view of the doors, select a wall, and on the View Control Bar, click Temporary Hide/Isolate ➤ Hide Category.
   All the walls in the view are hidden.
7 On the View Control Bar, click Temporary Hide/Isolate ➤ Reset Temporary Hide/Isolate.
8 Save the project file.

Adding Windows

In this exercise, you work in elevation and plan views to add windows to the model. You use alignment and dimension tools to more precisely position the windows.

1 Add windows in an elevation view:
   ■ Open the South elevation view, and zoom in to the building.
   ■ On the Design Bar, click Window.
   ■ On the Options Bar, clear Tag on Placement.
   ■ On the Options Bar, click Load.
   ■ In the left pane of the Load Family dialog, click Training Files, and open \Imperial\Families\Windows [Metric\Families\Windows].
   ■ Select Casement 3x3 with Trim.rfa [M_Casement 3x3 with Trim.rfa], and click Open.
   ■ Add 2 windows, approximately as shown. You will position them and align them with the top of the retaining wall later. If either of the windows spans an internal wall, a warning
about the conflict is displayed; close the warning. You will resolve any conflict by moving the windows while in a floor plan view.

2 Open the 01 Lower Level floor plan.  
Because the windows are at the top of the wall, they are above the current view range for the plan.

3 Modify the view range:
   ■ In the drawing area, right-click, and click View Properties.
   ■ In the Element Properties dialog, under Extents, for View Range, click Edit.
   ■ In the View Range dialog, for Cut plane Offset, enter 7' [2160mm].
   ■ Click OK twice.
   The windows are now visible in the south wall.

4 If necessary, move the windows to resolve the conflict with the wall:
   ■ Select the right window, and drag it 2' 6" [200mm] to the left side of the interior wall.  
     Select the window and edit the temporary dimensions, as needed.
   ■ Select the left window, and drag it 9' 6" [2775mm] to the right of the west wall.

5 Create a window type:
   ■ Open the South elevation view.
   ■ Select the window on the left, and click (Properties).
   ■ In the Element Properties dialog, click Edit/New.
   ■ In the Type Properties dialog, click Duplicate.
   ■ In the Name dialog, for Name, enter 36" x 36" [0915 x 0915mm], and click OK.
In the Type Properties dialog, under Dimensions, for Height, enter 3' [915mm].

Click OK twice.

6 Select the window on the right, and in the Type Selector, select Casement 3x3 with Trim : 36" x 36" [M_Casement 3x3 with Trim : 0915 x 0915mm].

7 Align the windows to the top of the retaining wall:

- On the Tools toolbar, click (Align).
- Select the top of the wall, and then select the top edge of the trim of one of the windows. Be careful to select the top of the wall, and not the 02 Entry Level line.
- Repeat for the second window.

8 Add windows in plan view:

- Open the 02 Entry Level floor plan, and zoom in to the west side of the model.
- In the drawing area, right-click, and click View Properties.
- In the Element Properties dialog, under Graphics, for Underlay, select None, and click OK.
- On the View toolbar, click to activate thin lines so that element lines maintain their true thickness in the zoomed view.
- On the Design Bar, click Window.
- On the Options Bar, verify that Tag on Placement is cleared.
- In the Type Selector, select Casement 3x3 with Trim : 36" x 72" [M_Casement 3x3 with Trim : 0915 x 1830mm], and place 3 windows on the outside edge of the west wall, as shown.
9 Reposition the windows to be equidistant from each other:

- On the Design Bar, click Dimension.
- Select the north wall, select each of the window centerlines, and then select the horizontal interior wall.
- Click to the left of the west wall to place the dimension line. Note that each of the four dimensions is different.
- Click ⏪, and then press ESC twice. The windows are moved so that all of the dimensions are equal.
- Select the interior wall that contains the doors; move it up or down to see how the design intent is maintained.
- Select the top wall, move it up 3' [1000 mm], and see how the walls resize and the windows redistribute equally within the wall.
- On the Standard toolbar, click 🔄 (Undo) once to restore the top wall to the original dimension.

10 Select the dimension line, and press DELETE. In the warning dialog, click OK to delete the line but maintain the constraints.
11 Zoom as desired, and open various plan, elevation, and 3D views to display the model results thus far.
12 Save the project file.
Adding a Curtain Wall

In this exercise, you change existing exterior walls to curtain walls. You then create a curtain wall type that you can apply to other walls using the Match Type tool.

1. Open the 01 Lower Level floor plan.
2. Create a curtain wall at the northeast corner of the building:
   - Zoom to the east wall.
   - On the Tools toolbar, click (Split), and split the east wall just above the door.
   - Click Modify.
   - While pressing \textit{CTRL}, select the upper portion of the east wall and the adjacent portion of the north wall.
   - In the Type Selector, select Curtain Wall : Storefront. If a warning displays, click to close it.
3 Create a curtain wall type:

- Select the north curtain wall at an end so the whole curtain wall is selected, and click (Properties).
  The tooltip and the status bar will confirm the selection.
- In the Element Properties dialog, click Edit/New.
- In the Type Properties dialog, click Duplicate.
- In the Name dialog, for Name, enter House 4’x4’ [House 1200 x 1200mm], and click OK.
- In the Type Properties dialog, under Vertical Grid Pattern, for Spacing, enter 4’ [1200mm].
- Under Horizontal Grid Pattern, for Spacing, enter 4’ [1200mm].
- Click OK twice.

4 Match the type of the north curtain wall to the east curtain wall:

- On the Tools toolbar, click (Match Type).
- Select the north curtain wall, and then select the east curtain wall.

5 Open the To Building 3D view.

The new spacing is applied to both curtain walls.

6 Save the project file.

**Attaching Walls to the Roof**

In this exercise, you attach interior and exterior walls to the roof. When you attach the curtain walls, Revit Architecture warns you of consequences and modifies the placement of mullions.

1 Open the 03 Roof floor plan.
2 Attach the basic walls:
   - While pressing CTRL, select all the interior walls and exterior walls, except the curtain walls.
   - On the Options Bar, click Attach.
For Attach Wall, verify Top is selected.
In the drawing area, select the roof.
Click in the drawing area, or click Modify on the Design Bar to end the command.

3 Attach the curtain walls:
Open the North elevation view.
Move the cursor over the curtain wall, and press TAB until the status bar indicates that the curtain wall is selected, select the outside edge of the curtain wall, and then click Attach.
Select the roof.
In the error dialog about curtain wall mullions, click Delete Elements.
Open the East elevation view, and attach the east curtain wall to the roof.

4 Open the To Building 3D view.
5 On the View Control Bar, click Shadows Off ➤ Shadows On.
All walls extend up to the roof. Note the spacing of the top row of mullions/panels; because the spacing parameter cannot be satisfied, mullions are created where the walls and roof attach.

6 Save the project file.

Modifying the Entry Deck

In this exercise, you modify the floor profile on the entry level to include a deck on the north side of the model.

1 Open the 02 Entry Level floor plan.
2 Edit the profile of the floor:
Select the floor, and on the Options Bar, click Edit.
On the Design Bar, click Lines.
On the Options Bar, clear Chain.
On the north side of the model, click on the north wall in line with the right vertical model line, move the cursor up 11' [3300mm], and click to place the endpoint of the line.

On the Options Bar, select Chain.

Trace the 6" [200mm] north wall from the left endpoint to the double door, and then down to the model line.

On the Tools toolbar, click (Split), and split the north model line at both sides of the door opening.

On the Design Bar, click Modify.

Select the segment at the door opening, and press DELETE.

On the Design Bar, click Lines, and complete the profile to the right of the door, as shown.

Draw a line beginning at the left endpoint of the north wall and extending up 3' 6" [1000mm].
- Draw a line beginning at the upper endpoint of the previous line and extending to the upper endpoint of the 11' [300mm] vertical line drawn previously.

- On the Design Bar, click Finish Sketch.
- In the alert dialog, click No.

3 Add a wall to the entry deck:
- On the Design Bar, click Wall.
- In the Type Selector, select Basic Wall : Retaining - 12" Concrete [Basic Wall : Retaining - 300mm Concrete].
- On the Options Bar, for Loc Line, select Core Face: Interior.
- Draw a wall from left to right on the slanted floor line, as shown.

- Select the wall, and click (Properties).
- In the Element Properties dialog, under Constraints, for Base Constraint, select 00 Foundation, and click OK.

4 In the drawing area, select the floor, and on the Options Bar, click Edit.
5 Select the short vertical line above the west wall, and drag it to the right, as shown.

6 On the Design Bar, click Finish Sketch.
7 In the alert dialog, click No.
8 Open the To Building 3D view.
9 Save the project file.
Adding a Sloped Floor

In this exercise, you add a sloped floor to the entry deck to create a ramp up to the entry door.

1. Open the 02 Entry Level floor plan.

2. Sketch the floor:
   - On the Design Bar, click Floor, and then click Lines.
   - On the Options Bar, verify that Chain is selected.
   - Beginning at the left endpoint of the 6" [200mm] north wall and moving counterclockwise, sketch the floor to complete the deck previously drawn, as shown.

   ![Sketch of the floor plan]

   - On the Design Bar, click Slope Arrow.
   - Select the midpoint of the west model line, and then select the east model line.

   ![Slope arrow selected]

   - Select the slope arrow, and click Properties.
   - In the Element Properties dialog, under Constraints, for Height Offset at Tail, enter -1' [-300mm], and click OK.
   - On the Design Bar, click Finish Sketch.
   - In the alert dialog, click No.

3. Open the North elevation view.
The sloped floor begins at the lower level and extends to the entry level.

![North elevation view with sloped floor]
4 If the sloped floor does not meet the slope of the terrain, edit the floor sketch, and change the Height Offset at Tail property of the slope arrow.

Adding Stairs and Railings

In this exercise, you complete the interior of the model by adding a staircase on the lower level, and then adding and modifying railings on the lower level and the entry level.

1 Open the 01 Lower Level floor plan.
2 Add stairs:
   - Zoom in to the east side of the model.
   - Click the Modelling tab of the Design Bar, and click Stairs.
   - Click near the double doors to start the stair run.
   - Move the cursor to the left until the tooltip indicates that no risers remain, and click to specify the stair endpoint.
   - On the Design Bar, click Finish Sketch.
3 Edit the floor profile:
   - Open the 02 Entry Level floor plan.
   - Zoom in to the east side of the model.
   - Select the floor, and on the Options Bar, click Edit.
On the Design Bar, click Lines.

On the Options Bar, verify that Chain is selected.

Click at the corner of the model lines below the stairs to specify the start point.

Move the cursor to the left, enter 6' [1800mm], and press ENTER.

Move the cursor up, enter 3’4” [1100mm], and press ENTER. This distance is the width of the stair and its stringers.

Move the cursor to the right, and click on the vertical line to complete the sketch.

On the Design Bar, click Modify.

Select the vertical model line closest to the stairs, and drag the bottom endpoint up to the endpoint of the short horizontal line drawn previously.

On the Design Bar, click Finish Sketch.

In the alert dialog, click No.

Move the stairs and railings:

Using a selection window, select the stairs and railings. To select only elements completely within the boundary of the window, drag the cursor from left to right.

On the Tools toolbar, click (Move).

Click the lower left corner of the stairs as the move start point.

Click the lower corner of the modified floor profile as the move end point, and then press ESC.
5 Modify the railing type:
■ Open the To Building 3D view.
■ While pressing CTRL, select both railings (zoom in as necessary).
■ In the Type Selector, select Railing : Guardrail - Pipe [Railing : 900mm Pipe].

6 Add a railing to the entry deck:
■ Open the 02 Entry Level floor plan.
■ On the Modelling tab of the Design Bar, click Railing, and then click Railing Properties.
■ In the Element Properties dialog, for Type, select Guardrail - Pipe [900mm Pipe], and click OK.
■ On the Options Bar, click (Pick Lines), and for Offset enter 4” [150mm].
■ Zoom to the entry deck on the north side of the model.
■ Click the interior of the angled floor on the right, and then click the interior of the adjacent vertical floor line, as shown.
■ On the Design Bar, click Modify, and then select the angled railing.
■ Drag the left endpoint to the right, so that the resulting railing extends just past the retaining wall.
■ Select the vertical railing, and drag the lower endpoint up until the resulting railing is 10’ [3000mm].
■ On the Design Bar, click Finish Sketch.
7 Add a railing on the north side of the stairs:

■ On the Design Bar, click Railing.

■ On the Options Bar, click (Pick Lines), and for Offset enter 4” [150mm].

■ Click to the left of the vertical floor line above the stairs, and then click above the left north edge of the stairs.

■ On the Design Bar, click Modify.

■ On the Tools toolbar, click (Trim/Extend).

■ Select the left side of the horizontal railing, and then select the vertical railing.

■ On the Design Bar, click Finish Sketch.

8 Add a railing to the balcony:

■ Zoom to the lower right corner of the model.

■ On the Design Bar, click Railing.

■ On the Options Bar, click (Pick Lines), and for Offset enter 4” [150mm].

■ Click above the south floor line, and, continuing in a counterclockwise direction, click the interior of the remaining 2 floor lines that define the balcony.
■ On the Design Bar, click Modify.

■ Select the last line drawn, and drag the left endpoint to the right, just to the east of the exterior wall.

■ Select the south railing line, and drag the left endpoint to the right until it touches the exterior wall near the door.

■ On the Design Bar, click Finish Sketch.
9 Zoom in to the stairs, and use the same technique to add a railing below the stairs. If necessary, drag the right endpoint of the railing to the wall on the right.

10 Open the To Building 3D view.
11 Save the project file.

Modifying the Roof

In this exercise, you modify the profile of the roof in order to extend the roof over the entry deck.

1 Open the 03 Roof floor plan.
2 In the drawing area, select the roof.
3 On the Options Bar, click Edit.
4 Modify the roof profile:
   ■ On the Tools toolbar, click \(\text{Split}\), and split the top edge of the roof profile by clicking to the right of the entry deck.
   ■ On the Design Bar, click Modify.
   ■ Select the left segment of the split roof line, and drag the right endpoint up to align with the endpoint of the slanted deck line.
   ■ Select the right segment of the roof line, and drag the left endpoint to the intersection with the vertical floor line.
   ■ On the Design Bar, click Lines.
   ■ Draw a line from the end of the right segment up to the end of the left segment.
On the Design Bar, click Finish Roof.

5 Open the To Building 3D view to view the result.
6 Save the project file.

Documenting the Project

In this exercise, you add tags to the project and schedule doors and rooms. You change an element in the door schedule and see that the change is automatically made in the associated plan. You also add color fill to rooms and modify crop regions for several views that you later add to a presentation sheet view.

1 Create a section view:
   - Open the 02 Entry Level floor plan.
   - Click the View tab of the Design Bar, and click Section.
   - Begin the section on the left side of the model and end it on the right side, making sure it cuts through the stairs.
On the Design Bar, click Modify.

Double-click the middle of the section head circle to display the section view. Alternatively, in the Project Browser under Views, expand Sections (Building Sections), and double-click Section 1.

2 Add door and window tags:
- Open the 02 Entry Level floor plan.
- Click the Drafting tab of the Design Bar, and click Tag All Not Tagged.
- In the Tag All Not Tagged dialog, press **CTRL**, and under Category, select Window Tags.
- Click OK.

Open the 01 Lower Level floor plan, and use the same procedure to tag all doors and windows in the view.

3 Create a door schedule:
- Click the View tab of the Design Bar, and click Schedule/Quantities.
- In the New Schedule dialog, for Category, select Doors, and click OK.
- In the Schedule Properties dialog, for Available fields, select Family and Type, and click Add.
Add the following fields: Width, Height, and Mark.

Using the Move Up button, move Mark to the top of the list so that it displays first in the schedule.

Click the Sorting/Grouping tab, for Sort by, select Mark, and click OK.

Double-click on the right column boundary of the Family and Type column to expand it to its full width.

<table>
<thead>
<tr>
<th>Mark</th>
<th>Door Schedule</th>
<th>Family and Type</th>
<th>Width</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Double-Glass 2 72&quot; x 84&quot;</td>
<td>2'-0&quot; x 7'-0&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Double-Glass 2 72&quot; x 84&quot;</td>
<td>2'-0&quot; x 7'-0&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Single-Glass 2 96&quot; x 84&quot;</td>
<td>2'-0&quot; x 7'-0&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Single-Flush 32&quot; x 84&quot;</td>
<td>2'-0&quot; x 7'-0&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Single-Flush 32&quot; x 84&quot;</td>
<td>2'-0&quot; x 7'-0&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Single-Flush 32&quot; x 84&quot;</td>
<td>2'-0&quot; x 7'-0&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Single-Flush 32&quot; x 84&quot;</td>
<td>2'-0&quot; x 7'-0&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Bifold-4 Panel 72&quot; x 84&quot;</td>
<td>2'-0&quot; x 7'-0&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Bifold-4 Panel 72&quot; x 84&quot;</td>
<td>2'-0&quot; x 7'-0&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4 Change a door schedule:

For the Mark 7 door, click the Family and Type field, and select Bifold-4 Panel : 60" x 84" [M_Bifold-4 Panel : 1525 x 2134mm].

Open the 01 Lower Level floor plan. Notice that the bedroom door tagged 7 is now a bifold door. Changes made in the schedule are automatically synchronized in the associated plan.

In the Type Selector, select Single-Flush : 30" x 84" [M_Single-Flush : 0762 x 2134mm] to return the door to the original family and type.

In the Project Browser, under Schedules/Quantities, double-click Door Schedule. The Mark 7 door is also restored to the original type in the schedule. This bidirectional associativity in Revit Architecture ensures that changes made to any part of the design are coordinated in all associated views, including schedules.

5 Modify the properties of the 3 retaining walls to specify them as bounding elements for room area calculation:

Open the 01 Lower Level floor plan.

On the Design Bar, click Modify.

While pressing CTRL, select the 3 retaining walls, and click (Properties).

In the Element Properties dialog, under Constraints, select Room Bounding, and click OK.

6 Create a Room schedule that contains the following fields:

Number

Name

Area

The schedule is empty but is updated when you add rooms and room tags to the building.

7 Add rooms and room tags on the entry level:

Open the 02 Entry Level floor plan.

Click the Room and Area tab of the Design Bar, and click Room.
**NOTE** If the tab is not displayed, right-click in the Design Bar, and click the tab name.

- Click to the left of the stairs to tag the large room, click in the upper room on the west side of the building, and then click in the small room on the west side.
- On the Design Bar, click Modify.
- Double-click the tag text in the large room, change it to Entry, and press ENTER.
- Change the tag text in room 2 to Bedroom, and the text in room 3 to Store.

8 Add rooms and room tags on the lower level:
- Open the 01 Lower Level floor plan.
- On the Room and Area tab of the Design Bar, click Room.
- Beginning in the large room on the right and moving clockwise, click in each room to add the tags.
- On the Design Bar, click Modify.
- Double-click the tag text in the large room, change it to Living Room, and then press ENTER.
- Change the tag text in room 5 to Bedroom, the text in room 6 to Bathroom, and the text in rooms 7 and 8 to Store.

9 Open the Room Schedule view to see that it includes data for the specified fields.

10 Define the floor in the Entry:
- Open the 02 Entry Level floor plan.
- On the Room and Area tab of the Design Bar, click Room Separation.
- Trace the floor line from the north wall down to and around the stairs to define the Entry room and create a separate floor profile for that room.
The area for the entry room is updated in the room schedule.

11 On the Design Bar, click Modify.

12 Modify tags:
   ■ Open the 01 Lower Level floor plan.
   ■ Double-click the tag for one of the windows in the south wall, enter A, and press ENTER.
   ■ In the alert dialog about changing a type parameter, click Yes.
   ■ Open the 02 Entry Level floor plan.
   ■ Double-click the tag for one of the windows in the west wall, enter B, and press ENTER.
   ■ In the alert dialog, click Yes.

13 Add color fill to the rooms:
   ■ On the Room and Area tab of the Design Bar, click Color Scheme Legend.
   ■ In the drawing area, click to the right of the building to place the color fill legend.
   ■ In the Choose Space Type and Color Scheme dialog, for Color Scheme, select Name, and click OK.

   ■ On the Design Bar, click Modify.
   ■ Select the left vertical wall, and move it slightly to the left.
     All of the walls resize to accommodate the new wall dimension. The color fill in the bedroom and storage room readjusts and the room areas are automatically updated.
   ■ Open the Room Schedule view to see that the bedroom and storage room areas have changed.
   ■ On the Standard toolbar, click (Undo) to restore the wall to its original dimension.
Reopen the 02 Entry Level floor plan and verify the wall has changed.

14 Open the 01 Lower Level floor plan and repeat the previous procedure in that view.

15 Modify a crop region to create a view for a sheet:
   ■ Open the 01 Lower Level floor plan.
   ■ On the View Control Bar, click Show Crop Region.
   ■ Enter ZF to zoom to fit the entire view in the drawing window.
   ■ Select the crop region, and drag the triangular blue controls to shrink the region around the model.
   ■ On the View Control Bar, click Hide Crop Region.

16 Using the same method, modify the following views:
   ■ 02 Entry Level floor plan
   ■ East elevation view
   ■ North elevation view
   Leave an area of sky above the roof in the elevation views.

Creating a Solar Study

In this exercise, you create an animation of the solar activity at a particular place and time in order to study the light and shadows that affect the building site.

1 Open the To Building 3D view.
2 On the View Control Bar, click Shadows ➤ Advanced Model Graphics.
3 In the Advanced Model Graphics Settings dialog:
   ■ Under Shadow, verify that Cast Shadows is selected, and for Contrast, specify 24.
Under Sun, click \( \text{...} \).

4 In the Sun and Shadows Settings dialog, click the Single-Day tab.

5 On the Single-Day tab, select any one of the solar studies in the list, and click Rename.

6 In the Rename dialog, for New, enter One Day Solar Study - Your Location - Summer Solstice (Winter Solstice if you are in the southern hemisphere), and click OK.

7 In the Sun and Shadows Settings dialog:

- Under Settings, for Place, click \( \text{...} \), select a city near your location, and click OK.
- For Date, enter 6/22/2008.
- For Time Interval, select 15 minutes.
- Clear Ground Plane at Level so that the shadows fall on the terrain.
- Click Apply, and then click OK.

8 In the Advanced Model Graphics Settings dialog, click Apply, and then click OK.

9 On the View Control Bar, click Shadows On ➤ Preview Solar Study.

10 On the Options Bar, click \( \text{(Play)} \).

The solar study animation is displayed, showing the progression at 15-minute intervals for the location and date specified.

11 Export the animation:

- Click File menu ➤ Export ➤ Animated Solar Study.
- In the Length/Format dialog, click OK.
- In the Export Animated Solar Study dialog, click the Desktop icon, and click Save.
- In the Video Compression dialog, for Compressor, select Full Frames (Uncompressed), and click OK.

The animation is played again as the AVI file is saved to your desktop.

- On your desktop, double-clicking on the AVI file displays the animation. Move the scroll bar to change the time.

Creating a Sheet

In this exercise, you add multiple views to a sheet. You also change the roof slope parameter to test the parametric capabilities of Revit Architecture. The walls that are attached to the roof are updated to maintain constraints with the modified roof.

1 Create a sheet:

- In the Project Browser, right-click Sheets (all), and click New Sheet.
- In the Select a Titleblock dialog, click OK.
- In the Project Browser, expand Sheets (all), right-click A101 - Unnamed, and click Rename.
- In the Sheet Title dialog, for Name, enter Presentation, and click OK.

2 Drag the 01 Lower Level floor plan from the Project Browser onto the upper left corner of the sheet, and click to place it.
3 Add the following views to the sheet:
   ■ 02 Entry Level floor plan
   ■ Section 1
   ■ East elevation
   ■ North elevation
   ■ Door Schedule
   ■ Room Schedule

If a view is too large to fit on the sheet, place it in the drawing, right-click, and click Activate View. Right-click again, select View Properties, and in the Element Properties dialog, for View Scale, select a different scale. Click OK, right-click the view again, select Deactivate View, and reposition it on the sheet.

4 Modify the roof slope:
   ■ In the drawing area, right-click the East elevation view, and click Activate View.
   ■ Select the roof.
   ■ On the Options Bar, click (Properties).
   ■ In the Element Properties dialog, under Dimensions, for Slope, enter 4”/12” [15°], and click OK.
     In all views, the walls and curtain walls that attach to the roof are extended and maintain the connection to the modified roof.
   ■ Change the slope parameter back to 1” [5°].
     The walls and curtain walls are updated with the roof.
   ■ In the East elevation view, double-click the height value for the 03 Roof Level, and enter a new value.
     In all views, the walls and curtain walls that attach to the roof maintain the connection to the modified roof.
   ■ Right-click, and click Deactivate View.
Any modification to the model is updated in the project drawings so that they are always coordinated. Try deleting or moving interior walls and doors; the changes will be made in all drawing views and schedules.